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1 Introduction

1.1 What is Likno Web Tooltips Builder

Create Web Tooltips in 5 easy steps!  

Likno Web Tooltips Builder is an application that serves as an interface to the popular jQuery open
source library, allowing you to create various "Tooltips" for web pages with minimal effort and coding.

It creates cross-browser jQuery tooltips that work alike in all browsers.

Through our builder you can easily create web tooltips with many options, like showing content added
easily through the interface (embedded), external or internal (AJAX) pages, and more.

The produced tooltips are fully cross-browser, i.e. they work alike in all browsers supporting DHTML
(like Firefox, Internet Explorer, Google Chrome, Opera, Mozilla, Konqueror, Safari and more).

Likno Web Tooltips Builder will save you a significant amount of time and effort required to fully
understand DHTML and Javascript code capable to support all browsers for creating powerful web
tooltips! 

Major Features Include:

    * Rich and powerful interface!
    * Create cross-browser jQuery tooltips to display information when visitors mouse over/click on page
elements (or even on page load!).
    * Use simple text, HTML code, images or whole pages as the content of your Tooltips.
    * Customize the style of your Tooltips through CSS.
    * Use multiple Tooltips on the same page.
    * Add dynamic content (database-driven or programmable) to your Tooltips through AJAX
techniques.
    * Use page elements to define the content of your Tooltips easily from within the page.
    * Open and close your Tooltips using a variety of opening/closing effects.
    * Create projects fast by using the ready-made examples already installed in the application.
    * Open Tooltips through a variety of triggering options: ID, CLASS, Tag Name, AllWebMenus item.
    * Set a Tooltip to open automatically on page load, instead of clicking on a page element.
    * Use complete help for all properties and procedures. Press F1 while you are on a property to
immediately receive Help for that property.
    * Live Examples available online.
    * Powered by the popular jQuery open source library.

...and many more (view the complete properties listing for more info).

1.2 What's new

Please check the new features, enhancements and fixes of the application by visiting the following
page online:
http://www.likno.com/jquery-tooltips/whatsnew.php   

http://www.likno.com/jquery-tooltips/whatsnew.php
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1.3 Terminology

Tooltip
"A tooltip is a common graphical user interface element, used in conjunction with a cursor, usually a
mouse pointer. The user hovers (or clicks) the cursor over an item and a tooltip may appear — a small
"hover box" with information about the item being hovered over (or clicked)." (source: 
http://en.wikipedia.org/wiki/Tooltip).

A tooltip is a part of a Tooltip project; all tooltips of this project have a similar functionality and
appearance that is defined in the "Style Editor" tab.

Tooltip Project
All tooltips contained within a Project share the same "Project Style" properties and are compiled in a
single project file. A project can contain several tooltips to be used on a single web page or different
web pages of the same website. 
If you want to have tooltips in separate projects read more information here.

Content
The Content of the tooltip is the information that displays. This content can be from a simple text, to
rich HTML content, and even a whole new page derived either as an AJAX call or as an external
website.

More information here.

Style
The style of the tooltip is its appearance (colors, background, borders, etc.) and behavior
(opening/closing effects, etc.). There is a common style for all tooltips in the same project (called
"Project Style") but you can also customize some of the common values per tooltip (through the
"Customize for"option).

1.4 About Likno Software

Likno Software is a software development company dedicated to creating quality software for
demanding web authors. Our development team is 100% internet-oriented, focused on creating tools
that minimize your web development efforts.

For detailed technical support you can access the following URL:
http://www.likno.com/support_page.html

For sales questions you may contact us at sales@likno.com.

Our web site is located at http://www.likno.com

Note: In case you came here to find your Installation ID, it can be found at the "Help -> Enter
Activation Code" command of the application menu, as shown below:

http://en.wikipedia.org/wiki/Tooltip
http://www.likno.com/support_page.html?source=app
http://www.likno.com?source=app


Introduction 4

© 2000-2014 Likno Software, all rights reserved



A Tooltip in 5 easy steps

Part

II



A Tooltip in 5 easy steps 6

© 2000-2014 Likno Software, all rights reserved

2 A Tooltip in 5 easy steps

2.1 Step 1: Select the content and properties for each Tooltip

Step 1

In the <Project Toolips> tab you can find all the content properties for each tooltip individually.

All properties are described and explained in the "Properties" help section.

Also read: Detailed integration info with your website (PDF)
FrontPage-specific integration info (PDF)

2.2 Step 2: Select the Project Style of your Tooltips

Step 2

In the <Style Editor> tab, choose the style properties that will apply to all tooltips of the project.

All settings are described and explained in the "Properties" help section.

Also read: Detailed integration info with your website (PDF)
FrontPage-specific integration info (PDF)

2.3 Step 3: Compile and Link the Project

Step 3

Compile:
Click on "Compile" button and select the location where you want to save your compiled JavaScript
files.

Link:
Once you have compiled your project, use the "Link" button to retrieve the necessary code that must
be added in your pages in order to link the compiled files to them.

Make sure that the correct path to the source javascript file has been used, otherwise the tooltips will
not appear.

Also read: Detailed integration info with your website (PDF)
FrontPage-specific integration info (PDF)

http://www.likno.com/downldd/Likno_Web_Tooltips_Builder-Website_Integration.pdf
http://www.likno.com/downldd/Likno_Web_Tooltips_Builder-Microsoft_FrontPage_Integration.pdf
http://www.likno.com/downldd/Likno_Web_Tooltips_Builder-Website_Integration.pdf
http://www.likno.com/downldd/Likno_Web_Tooltips_Builder-Microsoft_FrontPage_Integration.pdf
http://www.likno.com/downldd/Likno_Web_Tooltips_Builder-Website_Integration.pdf
http://www.likno.com/downldd/Likno_Web_Tooltips_Builder-Microsoft_FrontPage_Integration.pdf
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2.4 Step 4: Upload the files to your server

Step 4

Once you have compiled and linked your compiled javascript project to your pages, you will need to
upload the files to your web server. The files created by Likno Web Tooltips Builder during the
compilation phase are:

./likno-scripts/ (folder)

./likno-scripts/likno-tooltip-project.js *

./likno-scripts/likno-tooltip-lib.js

./likno-scripts/jquery.js

./likno-scripts/likno-tooltip-project/ *  (folder)
(all image files used by the tooltips)

where "./" is the "Site_Root" folder (also specified in Project Properties).

(* the highlighted names may be different if you changed the "Compiled Javascript Project" name in
Project Properties)

All those files have to be uploaded to your web server using your favorite FTP tool. Make sure that the
directory structure is kept exactly the same as is displayed here and also pay careful attention in order
to keep the case of the files when they are uploaded. You have also to make sure that the files are
placed in the same location relative to your HTML files as they are locally, in order for the directories
that were set while linking your compiled project locally to point to the right structure on your web
server.

Also read: Detailed integration info with your website (PDF)
FrontPage-specific integration info (PDF)

2.5 Step 5: Save your work

Step 5

Your Web Tooltips can be saved in an .wtt project file so that you can use/edit it in the future. Just
use Project->Save or Project->Save As for this process.

Once your file is modified you will need to compile it again (but not link it) and upload the new
likno-tooltip.js file to your web server. The likno-tooltip-lib.js file needs to be re-uploaded only if you
re-compile your project with a newer Likno Web Tooltips Builder version (since it may use an updated
tooltip-building library).

Also read: Detailed integration info with your website (PDF)
FrontPage-specific integration info (PDF)

http://www.likno.com/downldd/Likno_Web_Tooltips_Builder-Website_Integration.pdf
http://www.likno.com/downldd/Likno_Web_Tooltips_Builder-Microsoft_FrontPage_Integration.pdf
http://www.likno.com/downldd/Likno_Web_Tooltips_Builder-Website_Integration.pdf
http://www.likno.com/downldd/Likno_Web_Tooltips_Builder-Microsoft_FrontPage_Integration.pdf
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3 User Interface

3.1 Main window layout

Likno Web Tooltips Builder uses several tabs:

 Project Tooltips tab

Here you can add as many tooltips as you need in your project and specify their content.

 Style Editor tab 

Here you can modify the style properties that apply to the tooltips of the loaded project.

 Preview tab 

Here you can preview the tooltips that you have specified in the Project Tooltips tab - the tooltip that
will appear is the tooltip selected in the "Tooltips in Project" list. 

 Project Properties tab 

Here you can specify the compiled files and folders of the project, as well as the domain which the
project is compiled for.

3.2 Keyboard shortcuts

There are several shortcuts defined for quicker access to frequently used functions:

· F1
Provides context sensitive help for each property

· F2
Opens the Project Tooltips tab

· F3
Opens the Style Editor tab

· F5
Refreshes and opens the Preview tab

· F6
Opens the Project Properties tab

· Ctrl + F12
Opens the Compile dialog

· F8
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Compiles the project without any dialogs

· Shift + Ctrl + F12
Opens the "Link Compiled Project to Web Pages" dialog

· Ctrl + N
Creates a new project

· Ctrl + O 
Opens a .wtt project

· Ctrl + S
Saves the selected project
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4 Commands

4.1 Command: Project

New 
Creates a new Likno Web Tooltips project.    

Open
Opens a Likno Web Tooltips project.
The Likno Web Tooltips files are found under the .wtt extension.  

Save
Saves the selected project into a *.wtt file.

Save As 
Saves the current project with a different filename.

Save All Projects
Saves all loaded projects, but not the examples which are read-only.

Close Selected Project 
Closes the selected project.

Close All Projects
Closes all loaded projects, but not the examples which are always available.

Export Project
Exports the loaded project as a ZIP file in order to move it to other PCs without having problems with
the file paths of the linked images (the "assets" folder).

Exit 
Closes the Likno Web Tooltips Builder application.

4.2 Tools

4.2.1 Command: Compile Project

Compiles the .wtt project into a .js file that has to be linked to your web pages.

To use tooltips in your web pages you must take the following four steps:

Step 1. Compile the project     (note: spaces are not allowed in filename)

Step 2. Link the compiled project to your web pages
Step 3. Upload the necessary files and folders (see a description of these elements below)
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Step 4. Upload the web pages that contain the project link
(note: steps 2 & 4 are not necessary if you have already linked the project to your web pages and you only want to update your
tooltips)

How it works:

When compiling a project as likno-tooltip-project.js, the following elements are created inside the
same directory:

1. The core likno-tooltip-project.js javascript file.

2. The "Compiled Libraries" and "Compiled Images" folders as defined in Project Properties.

It is critical that you do not forget to upload the likno-scripts directory, where these files are
compiled.

Also read: Detailed integration info with your website (PDF)
FrontPage-specific integration info (PDF)

See also
Link Compiled Project to Web Page(s)

4.2.2 Command: Link Compiled Project to Web Pages

Links a compiled project (.js file) to a selection of web pages.

At this stage, the application inserts the necessary link into the selected web pages. No DHTML or
Javascript knowledge is required since the whole process is conducted by the application. The link is a
few lines of code and can be easily identified inside the source code by a related comment.

The linking process requires only two pieces of information:

1. The compiled project file (eg: likno-tooltip-project.js)
2. The web page(s) where the link will be added.

Obviously, you need to upload the updated web pages on the server so that the tooltips can be viewed
on-line. However, it is important that you also upload...

1. the compiled project file (eg: likno-tooltip-project.js)

2. the "likno-scripts" folder

3. the "likno-scripts/likno-tooltip-project" folder if you use images. Your folder may be different
depending on the name you choose to use for the compiled project file.

...at the same directory structure where they reside locally.
See the Compile Project command for more info on this issue.

To update the design of an already compiled project you should first make the changes to its
respective .wtt file and then recompile it. Provided that you did not change the name or the directory of
the compiled project, you do not need to re-link the project to the pages that already contain that link.

http://www.likno.com/downldd/Likno_Web_Tooltips_Builder-Website_Integration.pdf
http://www.likno.com/downldd/Likno_Web_Tooltips_Builder-Microsoft_FrontPage_Integration.pdf
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Notes:
Note about file extensions:
The link can be inserted in any kind of page, regardless of its extension. Just use the All Files (*.*) filter
to select web pages that have an extension other than the typical .html or .htm one.

Note for Dreamweaver users:
If you like, you can also link the compiled project to a template (.dwt) or a library (.lbi). Just select the
related directory (Templates or Library) and use the All Files (*.*) filter so that you can view the
template or library file.

The library (.lbi) is a special Dreamweaver file containing a collection of individual assets or copies of
assets that you can place in your web pages. That means the linking code can be added in a library
but you should make sure that the library should be placed as the first element after the BODY
opening tag (<body>) and that the linking code is the first element, listed in the library file itself.

The project does not have to be compiled inside the Templates directory. On the contrary, we do not
advise you to do so as you will have to upload the Templates directory on the server too. 

Note for FrontPage users:
Similarly to Dreamweaver, you can link your project into an include so that it can be used by all other
pages. Just make sure that this include contains only the project and that it is inserted immediately
before the </body> tag of the pages. 

Also read: Detailed integration info with your website (PDF)
FrontPage-specific integration info (PDF)

See also
Compile Project

4.2.3 Command: Project Properties

Allows you to specify the following properties and settings for your loaded project:

Compile Properties

Preview Panel Settings

4.2.3.1 Compile Properties

Allows you to specify the following properties and options for your loaded project:

The Site_Root folder is the location where your web site (your main index page) is locally stored.
It is also referred as the "Site Root" folder in other applications. It is very important that you specify the
correct folder here as it is used in the compile process.

http://www.likno.com/downldd/Likno_Web_Tooltips_Builder-Website_Integration.pdf
http://www.likno.com/downldd/Likno_Web_Tooltips_Builder-Microsoft_FrontPage_Integration.pdf
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The Compiled Javascript Project is the javascript file generated when you compile your
project. It defaults to likno-tooltip.js but you may as well change it to something else. Note that you can
use multiple tooltip projects in the same website by having different projects compiled using different
"Compiled Javascript Project" names.

Once you setup your "Site_Root folder", you are able to edit the "Compiled subfolders":

The Compiled Libraries subfolder (default: \likno-scripts) which contains the following:

likno-tooltip-lib.js The required Javascript tooltip-building Libraries. These are the javascript
files containing all the functions that build the tooltips and drive their
behavior.

likno-tooltip-project.js The compiled project file (actual name depends on your settings)

There is no apparent reason to change the libraries folder, so we recommend that you keep the
default value.

The Compiled Images subfolder (default: \likno-scripts\likno-tooltip-project) which contains any
image files used by your tooltips. If not uploaded, the tooltips will show no images. The missing image
sign ("x") may also appear in place of those images.

Custom folders may be required when two or more different tooltip projects are used in the same
website and images from both projects use the same names. This is the usual situation that may
require you to have a different subfolder for the produced images.

Custom folders may contain relative paths too (eg: ../). If you do so, the folder location will be
relative to the location of the compiled likno-tooltip-project.js file.

The Domain (website) where the compiled project will be used is very important as it
affects whether your tooltips are available to your online visitors or just you (for testing purposes).

You can always view (test) your tooltips by using a localhost or numeric IP on the browser but not
when using a "letter-based" domain (eg:www.fifa.com), unless you have purchased a domains
license and allocated a domain to that license.

For example, "fifa.com" uses the "83.231.250.129" numeric IP.
(find the numeric IP of any domain name here: http://www.hcidata.info/host2ip.cgi)

FIFA developers could then test their tooltips using any of the following:

c:/portfolio/fifa_site/page.html    (local hard drive)

http://localhost/page.html    (localhost)
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http://83.231.250.129/page.html    (their numeric IP)

But their actual visitors could not view the tooltips when using the respective "letter-based" domain:

http://www.fifa.com/page.html    (domain)

So, what FIFA could do is purchase the "3-Domain" license, allocate "fifa.com", get an Activation
Code and choose to compile for the "fifa.com" domain. Or simpler, purchase the "Unlimited
Domains" license, get an Activation Code and just compile for ANY domain. Any of these 2 options
would make the tooltips available for the "fifa.com" online visitors.

Note on "subdomains": Do not allocate subdomains, just allocate their major domain, as 10 of its
first-level subdomains will be supported by default (examples: "subdomain.fifa.com", "
subdomain2.fifa.com", but not "sub.subdomain.fifa.com"). For more than 10 subdomains
(or second-level subdomains) on the same domain, you need to purchase the "Unlimited Domains"
License.

4.2.3.2 Preview Panel Settings

Allows you to specify folders so that the Preview Panel can show images (if used) that are relative to
the page or site root.
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While these images will show online (on the actual site), the local Preview Panel cannot show them,
unless you specify local folders to browse from.

For previewing purposes, the Preview Panel locates graphics on the disk by searching for files in the
directories in the "Image Folders for Preview Panel" list.

By default the "Project Assets Folder" and the "Application Gallery Folder" are included in the Image
Folders list so that any images in those folders will be found automatically. You cannot remove them
from the list.

Please note that you must be careful to avoid duplicate graphics file names in different folders
(the standard folders or yours). If this occurs, the 1st match will "win" depending on how the order of
folders is (use the "move up/down" buttons to determine the priority of folders).

4.3 Command:  Help

Contents
Displays the contents of the help file. It also supports both keyword and full-text search.

Enter Activation Code
This is where you can enter an Activation Code. You will receive this Activation Code through your
Likno User Area account which is created after your purchase of a license for the application.
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Visit Likno on the Web
Visit our web site to contact us, get the latest information on new versions and products.

Check for Updates
Checks if newer versions have been released since the last time you installed the application.
It is recommended that you check for updates frequently as we regularly release improved
cross-browser support for your implementations.

About
Displays the About box of Likno Web Tooltips Builder, with your license information.
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5 Properties

5.1 Properties Overview

Properties are classified in the following categories:

The Project Tooltips properties, which define the content and opening method for each Tooltip of the
loaded project separately:

Content Source
Opens - When

The Project Style properties, which define the appearance and behavior of the tooltips of the loaded
project:

Opens - How
Opens - When
Closes - How
Closes - When
Positioning
Tooltip Size
Tooltip Border
Show Tip
Tooltip CSS

5.2 "Project Style" Properties

5.2.1 Opens - How

Choose an opening effect for the tooltips of your project, along with its duration/delay in milliseconds
(ms).

See also
Property: Closes - How
Property: Closes - When
Property: Opens - When

5.2.2 Opens - When

Choose if the tooltips should open when the mouse is "over" your specified element(s) or when you
"click" on them.

The rest of "Opens-When" properties are tooltip-specific and are specified through the per-tooltip
"Opens When" property instead, at "Project Tooltips" tab.

See also
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"Project Tooltips": Opens When
Property: Opens - How
Property: Closes - How
Property: Closes - When

5.2.3 Closes - How

Choose a closing effect for the tooltips of your project, along with its duration/delay in milliseconds

(ms).

See also
Property: Opens - How
Property: Closes - When
Property: Opens - When

5.2.4 Closes - When

Choose when the tooltip closes.

You have the following options:

· By moving the mouse outside the "target" element, i.e. the element relative to which the tooltip
appears.

· By clicking anywhere outside the tooltip area (on the page)

See also
Property: Opens - How
Property: Closes - How
Property: Opens - When

5.2.5 Positioning

Select where the tooltip opens.

You can match any corner (or side) of the "Target" element with any corner (or side) of the tooltip.

You can also use the offsets to further refine your positioning relative to the selected "anchor" point.

Option 1: Positioning the tooltip relative to the Trigger element
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This option makes the tooltip appear relative to the same element that triggers its appearance (a link
for example). So in this case the "Trigger" element and the "Target" element are the same.

Option 2: Positioning the tooltip relative to the mouse (when this enters the "Trigger"
element)

This option is similar to the previous "Target: the Trigger Element" option, with the difference that the
tooltip appears related to the "mouse tip" instead of the "Trigger" element itself.

Option 3: Positioning the tooltip relative to the browser's window

All you have to do is specify the Corner or Side of the browser window ("Target Anchor" property), the
"Tooltip Anchor" along with the Offsets X and Y and the tooltip will appear at that distance from your
selected window corner (or side).

Option 4: Positioning the tooltip relative to an element of your pages (span, div, td,
table, etc.)
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This option requires that you add extra code on the page but gives advanced flexibility (if needed).

How?

1. First make sure that the "page Element" option is selected at the <Target> property prior to the
project's compilation (see screenshot above)

2. Edit your HTML page

3. Choose the element where you want your tooltip to appear

4. Add the following parameter on that element's tag:

id="liknotooltip_positionID"

OR

id="<TooltipName>_positionID"

(in case you choose to "customize" the "Target" of a particular tooltip, through the "Edit style of
specific tooltip" option at the top of the "Style Editor (F3)")

This is all you have do. When a user browses your page, the Likno script detects the element with that
id parameter and shows the tooltip at the element's location. If the script does not detect the id, the
tooltip cannot appear.

You may also choose to use your own ID. For example, you may be using a Content Management
System that already applies its own "id" tag to every page element, thus not allowing you to add the
suggested ID to your selected element. In that case, you simply copy this "id" of your selected element
and paste it as the Element ID in the application.

Examples:

The tooltip is attached to a table using the following code:

<table id="liknotooltip_positionID" valign="top" width="150" height="150"
border="1">

The same technique applies if the chosen element is different, such as:

SPAN (the most generic element):

<span id="liknotooltip_positionID"> &nbsp; </span>
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TD:

<td id="liknotooltip_positionID" valign="top">&nbsp;</td>

Link:

<a id="liknotooltip_positionID" href="#">Tooltip attached to this
link.</a>

Image: (while you can add the id to an image it is recommended to use the independent "Target:
an Image" option instead, see below)

<img src="products1.gif" id="liknotooltip_positionID">

DIV:

<div id="liknotooltip_positionID"> &nbsp; </div>

Note: You may also use the "class" attribute instead of the "id" attribute under the same concept. The
script first tries to detect an "id" with the value that you specified, if it does not find one then it tries to
detect a "class" with the same value. If multiple page elements use this "class", then the first one
detected in the page will be used.

Option 5: Positioning the tooltip relative to an image existent in your pages

This option is similar to the previous option ("Target: a page Element") but the "element" now is an
image that already exists in your page (example: logo.gif) and no extra code in your page is required
(i.e. no "Element ID" needs to be added anywhere).

You only specify the filename of the image (which should exist in your page!) and your positioning is
complete: the tooltip will appear relative to that image.

5.2.6 Tooltip Size

Choose the dimensions (size) of the tooltip.

"Auto" determines its size based on the actual content of the tooltip.
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"Custom" allows you to set a standard size for the tooltip.

5.2.7 Tooltip Border

Choose the border properties of the tooltip.

Note that the "Width" value cannot be smaller from the "Radius" value.

This is enforced by the interface when you click on the "increase/decrease" buttons.

5.2.8 Show Tip

Choose the "tip" properties of the tooltip.

The tip is created on-the-fly, through HTML, and it is not a static image. This means that it can show
differently (in terms of "direction") depending on where the tooltip is positioned relative to the target
element.

Example:

However, you may use a background image for your tooltip style, like in "Example 08". This example
does not use the tip property as it has its own "tip", through the image design:
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As you can see above, the image is a unique design and cannot change automatically to follow the
tooltip position relative to the target element. This means that you have to take into account your
desired positioning when creating your background image.

In the above example, you can edit the background image in a photo editor, "flip the image vertically"
and save it as a new image. You can then use that new image for your tooltip's background (so that it
is placed below then link rather than above).

5.2.9 Tooltip CSS

Modify the default CSS code to change the style of the tooltip. 

Change the value of this property to change the style of your tooltips. The code used in this field is
pure CSS code.

For more information about CSS styling, visit http://www.likno.com/cssref

See also
Property: Tooltip Size
Property: Tooltip Positioning

http://www.likno.com/cssref
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5.3 "Project Windows" Properties

5.3.1 Content Source options

See the following options on how to specify the content of a tooltip:

Embedded
Attribute
Image
AJAX
External Site

5.3.1.1 Embedded

Add the content of the tooltip directly into the "Text/HTML" property.

You can either add simple text to be displayed, or more complex HTML code.

Notes: 

- The paths of any files (images, etc.) used inside the HTML should be relative to the location of the
web page that shows the tooltip. read more

- For the Preview Panel to be able to show images using Site_Root-relative paths (example: 
"/image1.gif") or Page-relative paths (example: "image1.gif" or "pics/image1.gif"), you need to add
them to the "Project Assets" folder or to any other local folder that you specify through the Image
Folders for Preview Panel list in Preview Panel Settings.

See also
How do I display a YouTube video in a Tooltip?
Content Source options

5.3.1.2 In Page

The tooltip shows content which is retrieved from a specified attribute (like "title", "alt", your own

attribute, etc.) that exists on the tooltip's "trigger" element.

View online tooltip examples (that use this "In Page" feature)

Read online how we use this feature on our own website (Use Case)

This is quite powerful, as you can open the same tooltip with different content that simply exists on

each element that opens it ("trigger" element). You do not have to specify any content inside the

application, you just edit your page to add/update/remove your tooltip's content per element.

In addition, this feature can be used on any page element that uses the specified attribute OR it can
be restricted to some of these elements through conditions of yours (read the "Opens - When" section
below).

http://www.likno.com/blog/tooltip-page-content/2180/
http://www.likno.com/blog/tooltip-page-alt-content/2189/


Likno Web Tooltips Builder User's Guide29

© 2000-2014 Likno Software, all rights reserved

Examples with the "title" (or "alt") attribute:

<a href='info.html' title='Show this text inside a tooltip!'>Info</a>

<img src='image.gif' alt='Show this text inside a tooltip!' />

Note: the "alt" attribute applies only to images, all other elements (tags) should use the "title"
attribute OR your custom one.

Read how we use the "alt" option (combined with the "SOME" option) on our own website here:
Use Case: Tooltip content retrieved from "Page", from the "ALT" attribute of "SOME" elements
that use a specific "CLASS" value (only)

<img src='image.gif' title='Show this text inside a tooltip!' />

<div title='Show this text inside a tooltip!'>
Blah... Blah... Blah...
</div>

<span title='Show this text inside a tooltip!'>
Blah... Blah... Blah...
</span>

You can use the "title" attribute on any elements you like, such as links ("a" tag), table cells ("td"
tag), images ("img" tag), DIVs ("div" tag), SPANs ("span" tag), etc. The "alt" attribute can also be
used for images ("img" tags only). This feature can be very useful if you want to automatically
replace the standard browser tooltips with stylish ones.

Same examples but with a custom attribute instead of the "title" (or "alt") attribute:

<a href='info.html' likno_tooltip='Show this text inside a tooltip!'
>Info</a>

<img src='image.gif' likno_tooltip='Show this text inside a tooltip!'

http://www.likno.com/blog/tooltip-page-alt-content/2189/
http://www.likno.com/blog/tooltip-page-alt-content/2189/
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/>

<div likno_tooltip='Show this text inside a tooltip!'>
Blah... Blah... Blah...
</div>

<span likno_tooltip='Show this text inside a tooltip!'>
Blah... Blah... Blah...
</span>

All the above page elements show the following content on your project's tooltip:

HOW TO SHOW ADVANCED (RICH) CONTENT (instead of simple text)

You have several methods to choose from:

<a href='info.html' likno_tooltip='<p>Show me in <b>BOLD</b></p>'
>Info</a>

This example shows that you can have HTML (instead of simple text) as the value of the
attribute. Be careful however because quotes or special characters can break it. 

Instead, you may use the "ID" or "CLASS" method (presented below) for showing complex HTML
on the tooltip without any problems!

<a href='info.html' likno_tooltip='lwtt_content[id=myID21]'>Info</a>

<div id='myID21' style='display:none;'>
<p> ANY HTML WITHIN THIS DIV WILL SHOW AT THE TOOLTIP ABOVE </p>
</div>

...or...

<img id='myID21' style='display:none;'
src='http://www.mysite.com/image1.gif' />

...etc.

You can use the "ID" attribute on any page element you like.

<a href='info.html' likno_tooltip='lwtt_content[class=myClass43]'
>Info</a>
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<div class='myClass43' style='display:none;'>
<p> ANY HTML WITHIN THIS DIV WILL SHOW AT THE TOOLTIP ABOVE </p>
</div>

...or...

<img class='myClass43' style='display:none;'
src='http://www.mysite.com/image1.gif' />

...etc.

You can use the "CLASS" attribute on any page element you like.

<a href='info.html' likno_tooltip='lwtt_content[imageurl=
http://www.mysite.com/image1.gif]'>Info</a>

This example shows that you can have a reference to an image as the value of the attribute.
This image is shown at the tooltip.

<a href='info.html' likno_tooltip='lwtt_content[ajaxurl=
http://www.mysite.com/products.html]'>Info</a>

This example shows that you can have a reference to an internal web page (note: within the
same site and without javascripts) as the value of the attribute. That page is shown at the tooltip.

<a href='info.html' likno_tooltip='lwtt_content[externalurl=
http://www.anywebsite.com/products.html]'>Info</a>

This example shows that you can have a reference to any external web page (note: any site,
with or without javascripts, a PDF, a Word document, etc.) as the value of the attribute. That page
is shown at the tooltip.

Note: Please do not use "auto" in the tooltip's "width" and "height" settings (specify a specific
width and height instead) as the tooltip cannot determine the actual size of the page.

Needless to say that all the above examples could also use the "title" attribute instead of the custom
attribute ("likno_tooltip" in this case), it is your choice.

WHAT ABOUT "ANY" or "SOME"?

As mentioned above, the "attribute" feature can be used on any element OR only some (specific)
elements of the page. You can choose this behavior through the "Opens - When" property below:
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Example 1 for "SOME" elements:

This image shows a Likno tooltip:

<img id="id23" src="image.gif" alt="Show this text inside a tooltip!" />

…but these ones not: 

<img id="other_id" src="image.gif" alt="Show this text inside a tooltip!" />
<img src="image.gif" alt="Show this text inside a tooltip!" />

Example 2 for "SOME" elements:

This image shows a Likno tooltip:

<img class="class45" src="image.gif" alt="Show this text inside a tooltip!" />

…but these ones not: 

<img class="other" src="image.gif" alt="Show this text inside a tooltip!" />
<img src="image.gif" alt="Show this text inside a tooltip!" />

Read how we use the "SOME" option combined with the "Class" option on our own website here:
Use Case: Tooltip content retrieved from "Page", from the "ALT" attribute of "SOME" elements that
use a specific "CLASS" value (only)

Example 3 for "SOME" elements:

http://www.likno.com/blog/tooltip-page-alt-content/2189/
http://www.likno.com/blog/tooltip-page-alt-content/2189/
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All images show a Likno tooltip:

<img src="image1.gif" alt="Show text for image 1 inside a tooltip!" />
<img src="image2.gif" alt="Show text for image 2 inside a tooltip!" />

…but other tags not: 

<a href="page.html" title="Show this text inside a tooltip!"> link text here </a>
<div title="Show this text inside a tooltip!"> page text here </div>

About the "Live" option:

If you check this option in combination with the "In Page" Content Source value, then your tooltips will
also be applied to any page elements that are created after your page loads (otherwise not).

This is useful when you want to show tooltips on page elements that are created dynamically
afterwards, through javascript or AJAX for example.

See also
Content Source options
View online tooltip examples (that use this "In Page" feature)
Read online how we use this feature on our own website (Use Case)

5.3.1.3 Image

The content of the tooltip is an image. 

The image can be sourced either from the project's "assets" folder or from a web location (relative or

absolute to the loaded page).

See also
Content Source options

5.3.1.4 AJAX

The content of the tooltip is contained in a page that is located in your domain and does NOT have

JavaScript code. AJAX does not allow calling content (HTML) from a page outside your domain. Add

the path/name of the file in the "Page Link" property.

http://www.likno.com/blog/tooltip-page-content/2180/
http://www.likno.com/blog/tooltip-page-alt-content/2189/
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Examples: ajax1.php

ajax2.htm

/ajaxpages/ajax1.php

Notes:

- The path of the page should be relative to the location of the web page that shows the

tooltip.

- The entered page should be present on your website, the Preview cannot show it!

- You cannot use absolute URLs, such as http:// or https://, choose the "External" option

for this.

See also
Content Source options

5.3.1.5 External

The content of the tooltip is an external site (e.g. Google) or page.

Add the URL of the site you want to be displayed at the "Page Link" property.

Example: http://www.google.com

See also
Content Source options

5.3.1.6 AllWebMenus

This option is used in combination with AllWebMenus only.

Important! This feature works with AllWebMenus 5.2.810 or above (released on January 21, 2010).

It can be used to replace the default browser tooltip on your menu items with your selected tooltip,

in terms of appearance (not content).

How?

1. In Likno Web Tooltips Builder, compile and link your tooltip project to the page(s) where your
menu appears.

2. Copy the name of your tooltip project, as shown here:
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3. In AllWebMenus (build #810 or above), load your menu project.

4. Select the menu items or item styles that you want to show the custom tooltip (instead of the
default one), and paste the above value to their <Tooltip Style> property:
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5. This is all you need to do. Just make sure that the compiled tooltip project is also linked to the
web page where your menu appears. In pages where the tooltip project is not linked, the default
browser tooltip is shown instead.

Example: If you want all your menu items to show the appearance of a custom tooltip, named
"Tooltip_1", you should enter this value at the <Tooltip Style> property in all 3 item styles:

Main Items Style
Sub Items Style
Sub Items Style+

Note that the Likno Web Tooltips Builder project is used to change the style (appearance) of the menu

tooltips, NOT their content.
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Otherwise, all tooltips of all menu items would show the same content, which is not a desirable feature.

Each menu item (in AllWebMenus) has a different "Tooltip" value to show.

Example:
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Do not forget that both your menu and tooltip projects should be linked to the page, otherwise the

menu will not be able to locate the tooltip on page and the default browser tooltip will show instead.

View an online example of a menu that uses tooltips

Also view a video on how to use this feature!

See also
Content Source options

5.3.2 Opens When ("Trigger")

Select what makes your tooltip to appear. 

You have 2 options:

OPTION 1: "Attribute-related"

This option is available ONLY when the "Attribute" value is used as the "Source" of the tooltip
content:

You get the following option:

http://www.likno.com/jquery-tooltips/examples.php?example=allwebmenus
http://www.likno.com/blog/html-tooltips-allwebmenus-integration/1297/
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The tooltip opens when the user interacts with ANY page element that uses your specified attribute
("title", "alt" or custom).

For example, if you use this code on your page...

<img src="image.gif" alt="Show this text inside a tooltip!" />

OR this...

<div title="Show this text inside a tooltip!">sample text here</div>

OR this...

<p myattribute="Show this text inside a tooltip!">sample text here</p>

...the tooltip will appear with the following content:

You can use the "title", "alt" or custom attribute on any element you like, such as "a", "td", "img",
"div", etc.

OPTION 2: "Target, ID, Class, or Tag"

The tooltip opens when the user interacts (mouse over or click) with specific Page Elements that

use a at least one of the following attributes inside their HTML code:

Target, ID, Class, or Tag

Examples:

If you choose to use the  Target  option, add the target="tooltip_name" value to one

element in your page, as shown below:

<a href="#" target="tooltip_name">This opens your Tooltip</a>

For example, if the tooltip's name is "Tooltip_1", then the code to use is the following:

<a href="#" target="Tooltip_1">This opens your Tooltip</a>
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For the ID and Class options, let's assume that you decide to enter the value  myTooltip 

at the <Opens - When> property.

If you are using the  ID  option, add the "myTooltip" value to one element in your page, as

shown below:

<a id="myTooltip" href="javascript:void(0)">This opens your Tooltip</a>

<div id="myTooltip">This opens your Tooltip</div>

<p id="myTooltip">This opens your Tooltip</p>

<span id="myTooltip">This opens your Tooltip</span>

<img id="myTooltip" href="image_here.jpg">

<table id="myTooltip"><tr><td>This opens your Tooltip</td></tr></table>

<input id="myTooltip" type="button" value="This opens your Tooltip" />

   ...or whatever other element you like.

Note: Do NOT use the same "ID" on more than one element. The "ID" identifies a 

single element only. Troubleshooting on common errors 

If you are using the  Class  option, add the "myTooltip" value to one (or more) elements

in your page, as shown below:

<a class="myTooltip" href="javascript:void(0)">This opens your Tooltip</a>

<div class="myTooltip">This opens your Tooltip</div>

<p class="myTooltip">This opens your Tooltip</p>

<span class="myTooltip">This opens your Tooltip</span>

<img class="myTooltip" href="image_here.jpg">

<table class="myTooltip"><tr><td>This opens your Tooltip</td></tr></table>

<input class="myTooltip" type="button" value="This opens your Tooltip" />

   ...or whatever other element you like.

Note: Contrary to the "ID" option, you CAN use the same "Class" on more than one

element. In that manner you can open the same tooltip by interacting with different

elements of the same page. Troubleshooting on common errors
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If you are using the  Tag  option, all page elements using this tag will show the tooltip.

Possible Values:  a (most common use)

img

p

table

etc.

For example, if you use , all images of the page will

automatically show a tooltip when the user interacts with them. You can use this to show a

tooltip on all images like the following: "Click on the image to show its larger version" OR

"Right-click here and click Save As to download the image", etc.

Note: This option applies to ALL elements using the same tag on the same page. So if

you wanted a specific image NOT to show the tooltip, you cannot.

OPTION 3: "Opens on Page Load"

The tooltip opens when the page appears.

Check this option and the tooltip will automatically appear after the page is fully loaded.

Where? The tooltip will appear relative to its "Target", as specified at the Positioning property of the

Style Editor. 

Any page parameters specified there should be found on page, otherwise the tooltip will not open

on page load. 

You also need to have a "Trigger" element for that  tooltip on page, otherwise the tooltip will also not

open on page load. Any opening method ("trigger" method) can be used (you need to have at least

one).

Note: Only one tooltip can open automatically on page load, so do not use this option on multiple

tooltips on the same page.

See also
Troubleshooting on common errors 
Property: Closes - How
Property: Closes - When
Property: Opens - How



How Do I...

Part

VI



Likno Web Tooltips Builder User's Guide43

© 2000-2014 Likno Software, all rights reserved

6 How Do I...

6.1 Find my INSTALLATION ID

In order to activate your license you need to login to your Likno User Area and provide us with the
unique Installation ID of your current installation.

Your Installation ID can be found at the "Help -> Enter Activation Code" option of the application
menu.

6.2 Purchase/Activate

Step 1. Purchase
· Access the online registration page located at http://www.likno.com/jquery-tooltips/purchase.php
· Click on your preferred method of payment and enter the necessary info in the order form
You will soon receive an e-mail containing instructions on how to get the Activation Code to use it in
your installation.

Step 2. Activate your Installation
· Choose the "Help -> Enter Activation Code" menu option in the application
· Enter your Activation Code

You will need to have "Full Admin rights", read how here.

Following these simple steps you will be a registered user and you will be able to take full advantage
of the Likno Web Tooltips Builder features.

Methods of payment
There are many flexible payment options:

· Credit Card Orders (all major credit cards accepted)
· Phone Orders (toll-free)
· Mail Orders (pay by check)
· Fax Orders
· Purchase Orders

All on-line transactions are protected by an extremely high level of encryption, the highest allowed by
law.

6.3 Use the application with my favorite Web Authoring tool
(Dreamweaver, Expression Web, etc.)

Likno Web Tooltips Builder collaborates with all the common Web Authoring tools.

Also read: Detailed integration info with your website (PDF)
FrontPage-specific integration info (PDF)

http://www.likno.com/jquery-tooltips/purchase.php?source=app
http://www.likno.com/downldd/Likno_Web_Tooltips_Builder-Website_Integration.pdf
http://www.likno.com/downldd/Likno_Web_Tooltips_Builder-Microsoft_FrontPage_Integration.pdf
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6.4 Add effects when the tooltip opens or closes

Change the <Opens - How> and the <Closes - How> properties under the "Style Editor" tab.

See also
Property: Opens - How
Property: Closes - How

6.5 Change the position where the tooltips appear

Change the <Tooltip Positioning> property under the "Style Editor" tab.

See also
Property: Tooltip Positioning

6.6 Load with AJAX the content of a tooltip

You might need to load the content of one of your tooltips from another file in your server at the time
you display that tooltip. In that case you need to use the AJAX technique in order to load a remote
HTML file and inject its contents into the DOM.

This technique is included into the application, and the only thing you need to do is to select the "Ajax"
value in the <Content Source> property under the "Project Tooltips" tab, and then define the path
and name of the file that you want to display in the <Page Link> property below.

Note! Due to security issues you are not allowed to enter an absolute path as the value of the call
property. You can only call a file that resides within your site by using a relative path.

See also
Content Source
Source: AJAX

6.7 Load an external site as the content of a tooltip

You might need to load a full site as the content of one of your tooltips. 

In that case you have to select the "External Site" value in the <Content Source> property under the
"Project Tooltips" tab, and then define the URL of the site that you want to display in the <Page Link>
property below.

See also
Property: Content Source
Source: External

6.8 Use multiple Tooltip projects in the same page

There is no restriction in the number of Tooltip projects that you can use in the same page.

You only need to define a different name for the compiled JavaScript file (our default 
likno-tooltip-project.js) from the Project Properties of the application and make sure to link correctly the
different projects to your pages.
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Note! It is very important for the tooltips of the different projects to be triggered by different elements of
the page. You cannot associate an element of your page with two different tooltips.

Also read Troubleshooting on common errors about multiple projects and tooltip names.

6.9 Properly use paths in the "Website Folder" option

Contrary to the "Project Assets" option, this property is free text as you may need to enter both the
path and the filename of the website image.

You can use paths to the image file in 3 different ways:

"Absolute" paths:

· http://www.likno.com/jquery-tooltips/assets-app/close.gif

· http://www.mysite.com/pics/image1.gif

· https://www.google.com/image2.gif

"Document-relative" paths:
(image folder is relative to the folder of the loaded page that opens the tooltip)

· close.gif

· pics/close.gif

· ../close2.gif

"Site_Root-relative" paths:
(image folder is relative to the Site Root folder)

· /close.gif

· /pics/close.gif

· /close2.gif

Note: For the Preview Panel to be able to show images using Site_Root-relative paths (example:
"/image1.gif") or Page-relative paths (example: "image1.gif" or "pics/image1.gif"), you need to add
them to the "Project Assets" folder or to any other local folder that you specify through the Image
Folders for Preview Panel list in Preview Panel Settings.
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6.10 Display a video/movie in a Tooltip?

You can load and display a video/movie inside a tooltip.

Open "Example 18" inside the application to see this functionality.

How is this setup?

Copy the video's "embed code" from YouTube (for example) and paste it in the "Text/HTML" property
of the "Embedded" option, inside the "Project Tooltips" tab.

You can also change the "Window Width" and "Window Height" properties in "Style Editor" tab, to fit
the width and height of the video and avoid scrollbars (or just use "auto" there).

To show your own video, just replace the "<object>" section with its respective embed code:

<object width="560" height="340">
<param name="movie"
value="http://www.youtube.com/v/d41Y9MqXrgE&hl=en&fs=1"></param>
<param name="flashvars"
value="fmt_url_map=34%7Chttp%3A%2F%2Fv12.lscache5.c.youtube.com%2Fvideo
playback"></param>
<param name="allowFullScreen" value="true"></param>
<param name="allowscriptaccess" value="always"></param>
<embed src="http://www.youtube.com/v/d41Y9MqXrgE&hl=en&fs=1"
type="application/x-shockwave-flash" allowscriptaccess="always"
allowfullscreen="true" width="560" height="340"></embed>
</object>

Exactly the same would apply for other movie types, such as Flash movies.

Note: If you want to support IE6 (which is dropped by YouTube), you need to add the following
parameter inside the embed code that you take from YouTube:

<param name="flashvars"
value="fmt_url_map=34%7Chttp%3A%2F%2Fv12.lscache5.c.youtube.com%2Fvideo
playback"></param>

6.11 Use the "background-image" value in CSS properties

The following is an example of CSS that applies a background image to the tooltip through the 
background-image value:
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font-family:Tahoma,Verdana,Arial,Helvetica,sans-serif; font-size:9px; line-height:13px;
color:#21397D; padding: 20px 13px 13px 13px; background-image:
url(background-plasticplate.png); background-repeat: no-repeat; text-align:center;
background-position:top left;

1. Location of the image

The project needs to know where to find this image, otherwise it will not be displayed in the Preview
Panel and will not be compiled either.

You should put this image inside the project's "Assets" folder, which is a subfolder at the folder where
the project is located.

To demonstrate this, just open the "Example 06.wtt"...

 

... go to the "Style Editor tab...

...and edit the Tooltip CSS value:

There you will find the CSS mentioned in the beginning, that uses the background-image:
url(background-plasticplate.png) value.

Now, open the "assets" folder of this example, which should be at:

C:\Program Files\Likno Web Tooltips Builder\Examples\Example 06-assets
(the installation path may be different in your computer)

There you will find the image file background-plasticplate.png.

If that image wasn't there, the background could not appear.

So, if you ever use a background image in your CSS, make sure that you copy this image at the
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project asset's folder first, otherwise the image cannot be used by the compiled project.

2. Adjusting the width/height of the tooltip and "background-image"
considerations

When a tooltip uses a "background-image" on its CSS, this image can either "repeat" itself (tiles
within the background) or "no-repeat" (shows as is, once).

This is determined by the "background-repeat" CSS value:

background-repeat: no-repeat;
OR

background-repeat: repeat;
OR

no existence of this property, which defaults to "background-repeat: repeat;"

Why is this important?

1. When the "no-repeat" value is used, the tooltip may not show properly when you change the
size ("Width" or "Height"). To show the tooltip properly when making it bigger or smaller, you
need to also resize the background image with an image editor.

2. This is not the case when the "repeat" value is used (or no value is used at all). Since the image
tiles and acts as a "texture", no image resizing is required when changing the tooltip size. 

Tip on "texture" images: 

AllWebMenus has plenty of textures you can copy and use as background images:

http://www.likno.com/allwebmenusinfo.html
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7 What is...

7.1 The HTML Linking Code

This is the code added in the HTML of the page during the linking process in order to link the
necessary files to your page.

This section looks like the following one (yours may be slightly different):

<!-- ******** BEGIN LIKNO WEB TOOLTIPS CODE FOR likno-tooltip-project
******** -->
<script type="text/javascript">var lwttLinkedBy="LiknoWebTooltips
[1]",lwttName="likno-tooltip-project",lwttBN="2";</script><script
charset="UTF-8" src="likno-scripts/likno-tooltip-project.js"
type="text/javascript"></script></script>
<!-- ******** END LIKNO WEB TOOLTIPS CODE FOR likno-tooltip-project
******** -->

7.2 The Internet Explorer Information Bar Warning

When you preview a  local web page in Internet Explorer (IE6 XP SP2 +, IE7) that contains javascript
(like our scripts do), you will get the following message:

[To help protect your security, Internet Explorer has restricted this webpage from running scripts or
ActiveX controls that could access your computer. Click here for options... ] 

This is not a problem, as the "security" warning never appears online on your actual pages. It is
not only related to Likno Software products but to all javascripts running on your pages locally.
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This default behavior of Internet Explorer only happens when viewing pages saved to the local
computer and only in Internet Explorer.
This does not happen when pages have been uploaded to a web server and are then viewed online.

To overpass this Internet Explorer warning, you can click on the message bar and select "Allow
Blocked Content":

 

Then, a warning dialog will appear and you can just press "Yes" for the web page to properly load all
the javascript related files:
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(do not worry about the warning, our scripts are 100% safe)

You can read more about the IE Information bar at:
http://support.microsoft.com/kb/843017 (Windows XP)
http://windowshelp.microsoft.com/Windows/en-US/Help/91b1038d-3f53-43a3-8bd8-9551e7c0b7c6103
3.mspx (Windows Vista) 

7.3 The "Colors detected in this CSS" feature

This feature allows you to change a color in a CSS property, by using an advanced Color Picker
control instead of typing its HEX code.

How does this work?

When you edit any CSS property, the application tries to detect the colors that the CSS text is using, by
detecting their HEX code:

http://support.microsoft.com/kb/843017
http://windowshelp.microsoft.com/Windows/en-US/Help/91b1038d-3f53-43a3-8bd8-9551e7c0b7c61033.mspx
http://windowshelp.microsoft.com/Windows/en-US/Help/91b1038d-3f53-43a3-8bd8-9551e7c0b7c61033.mspx
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Note that only the 3-digit or 6-digit HEX syntax (starting with a #) can be detected by the Color Picker
control, such as:

color: #0000FF;

The following (valid) color syntaxes are not detected for easy editing (but are still functional as CSS
values):

color: blue;
color: rgb(0,0,255);
color: rgb(0%,0%,100%);

7.4 The "Relative paths detected in this HTML" feature

This feature detects all "relative" (not absolute) paths used by resources (images, files, etc.) inside the
HTML properties ("Embedded HTML"), so that you check if these point to the correct location relative
to the online page that contains the tooltip.

For example, let's assume that you have the following website structure...

...and that the "page_with_tab_control.html" is the page where you have your tooltip added.

If you want to show "image2.png" in a tooltip, this is how its "Embedded HTML" should look like:

<div style='padding: 21px 0 20px 17px; line-height: 14px;'>

<img src="images/image2.png" width="32" height="32" border="0"
style="margin: -2px 8px 15px 0; float: left;"/>

Text here, next to the image...

</div>

OR   src="/images/image2.png"   but NOT   src="image2.png".
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Why?

Because, the compiled tooltip seeks "relative" resources (images, files, etc. that use "relative" paths in
the "HTML" property) based on the page that shows it. And in this example the image is located in a
subfolder of where the page is located.

As a "worry-free" alternative you can use "absolute" paths, like 
http://www.likno.com/images/image2.png.

Note for the Preview Panel only: For the Preview Panel to be able to show images using
Site_Root-relative paths (example: "/image1.gif") or Page-relative paths (example: "image1.gif" or
"pics/image1.gif"), you need to add them to the "Project Assets" folder or to any other local folder that
you specify through the Image Folders for Preview Panel list in Preview Panel Settings.
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8 FAQ and Tips

8.1 Troubleshooting

This is a collection of quick tips to avoid trouble. 

Note: An Online Knowledge Base is also available with more information and up-to-date content.
Please check this knowledge base also.

I added the code in my page but nothing happens.
- Make sure that you have linked the project correctly.
- Make sure that you selected the correct domain before compiling (Project Properties).
- Make sure that you uploaded the likno-scripts directory after you compiled your project.

I added a second Tooltips project to my web page and now nothing works properly.
Make sure that the two projects and their tooltips have different names.

The content of my tooltip appears some pixels outside the Tooltip.
This could happen if you are using in your page the "box sizing" CSS code in order to determine the
behavior or borders, paddings, etc of your elements. Our script overrides these values, however it is
possible that you have used the code below:

* {
box-sizing: border-box !important;
-moz-box-sizing: border-box !important;
-webkit-box-sizing: border-box !important;
-ms-box-sizing: border-box !important;

}

The "!important" part of the above code defines this code to override any other definition of these CSS
rules. Therefore our script could not override it.
You can simply remove the "!important" part in the above definitions and your tooltip will be displayed
properly.

Filenames:
· Spaces in the compiled project name are not allowed as they are not parsed properly by some

browsers. As an example, use "main_project.js" or "mainproject.js" instead of "main project.js".

· Avoid using filenames that contain special characters, like quotes ("), apostrophes ('), etc. In most
cases these characters will produce an error.

8.2 "Full Admin rights" and the activation process

In order to activate Likno Web Tooltips Builder you need to be an "administrator" on that PC.
Otherwise, the activation process fails.

There are some cases (Windows Vista or 7 mostly) where you might think that you are administrator
but you miss certain rights that are required by the activation process (you may be a "protected
administrator' instead).

http://www.likno.com/blog/knowledgebase/
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To get "full" administrator rights for the activation process,choose "Yes" on the following popup
window:

(this window appears only for the activation process, you will not see that again after you activate)

If an administrator password is requested and you do not have this, then please contact your
administrator to activate Likno Web Tooltips Builder through the administrator account.
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